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In today’s fast-paced, remote-friendly world, businesses are increasingly relying on tools that
enable seamless access to applications from anywhere. Windows Server Remote Desktop
Services (RDS) is a robust solution that allows organizations to centralize application
management while providing users with secure and efficient access to their work tools. With
RDS, you can publish individual applications—referred to as RemoteApps—without exposing the
entire desktop environment, making it a versatile choice for IT administrators and end-users
alike.

In this guide, titled “How to Publish a Remote Application using Windows Server RDS”, we'll walk
you through the process of configuring RDS and publishing a RemoteApp step-by-step. Whether
you're an IT professional setting up RDS for the first time or looking to fine-tune your
deployment, this article will provide the insights you need to get started. From installation to
distribution and troubleshooting, you'll learn how to make RemoteApp an integral part of your
organization’s productivity toolkit. Let’s dive in!

PRE-REQUISITES

Before we begin, make sure you have the following pre-requisites in place:

¢ A Windows Server machine with Remote Desktop Services installed.

e A user account with administrative privileges on the server.

e The application you want to publish as a RemoteApp installed on the server.
* A network connection to the server.

A client machine with Remote Desktop Connection installed.

e A user account with access to the RemoteApp.

STEP 1: INSTALL REMOTE DESKTOP SERVICES

The first step in publishing a RemoteApp is to install the Remote Desktop Services role on your
Windows Server machine. Thankfully for us, | have already written a guide on how to install
Remote Desktop Services on Windows Server. You can find the guide How to Install Remote
Desktop Services on Windows Server 2022.
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STEP 2: CONFIGURE YOUR FIREWALL

Before you can publish a RemoteApp, you need to ensure that your firewall is configured to
allow Remote Desktop connections. We will need to open File and Printer Sharing ports (SMB) to
allow the RemoteApp to access shared resources on the network.

To open the File and Printer Sharing ports, follow these steps:

1. In the Server Manager, click on the Tools menu and select Windows Defender
Firewall with Advanced Security.

@ ¥ Server Manager * Remote Desktop Services * Collections * APP-01

Component Services

_ D_I PROPERTIES CONNECTIONS Computer Management
[ Overview Properties of the collection [Tasks =] Last refreshed on 11/26/2024 7:58:32 Defragment and Optimize Drives

i Servers Collection Type Session - Disk Cleanup

[ Collections Resources Remote Desktop Event Viewer

S User Group ALBCIEWeo6 Users Server EN Veer Internet Information Services (II5) Manager
- iSCS! Initiator

o APP-0l.albcie.com ALBCIE\louis.ou Local Security Policy

?'\ Microsoft Azure Services

g

Network Policy Server
ODBC Data Sources (32-bit)
ODEC Data Sources (64-bit)

REMOTEAPP PROGRAMS

Published RemoteApp programs | 0 total Performance Monitor
Recovery Drive

Remate Desktop is published for the users of the collection Registry Editor
Remote Desktop Services »
Publish RemoteApp programs Fosouree Monitor
Publishing RemateApp programs will unpublish the Remote Desktap. Services

System Configuration

System Information
Task Scheduler

Windows Defender Firewall with Advanced Security
Windows Memory Diagnostic

Windows PowerShell

Windows PowerShell (x86)

Windows Server Backup

HOST SERVERS
Last refreshed on 11/26/2024 8:21:03 AM | All servers | 1 total
Filter » [OR o)
R Type here to search =i} b F EJEJ

2. In the Windows Defender Firewall with Advanced Security window, click on Inbound
Rules.
3. Scroll down and locate the rules named File and Printer Sharing (SMB-1In).
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@ Windows Defender Firewall with Advanced Security -
File Action View Help
| 7@ = HID
W Windows Defender Frewall i Actions
Mlinotnd Fifes Name Group - Profile  Ensbled  Action  Ovemide  Program  Local Addre: || Inbound Rules -
&3 Outbound Rules
By Connection Security Rules || @ File and Printer Sharing (Echo Request - ICMPvd-In) File and Printer Sharing Private  Ves Allow  No System  Any @ NewRule..
+ B, Monitoring [ 3File and Printer Sharing (Echo Request - ICMPva-In) File and Printer Sharing Domai... Allow System T Fiter oy Profie N
File and Printer Sharing (Echo Request - ICMPv6-In) File and Printer Sharing Domai.. No Allow  No System Ay
9 File and Printer Sharing (Echo Request - ICMPv6-In) File and Printer Sharing Private Vs Alow  No System  Any T Filter by State *
€ File and Printer Sharing (LLMNR-UDP-In) File and Printer Sharing Private  Ves Allow  No SESystem... Any T Filter by Group »
File and Printer Sharing (LLMNR-UDP-In) File and Printer Sharing No Allow  No SeSystem... Any View 1y
File and Printer Sharing (NB-Datagram-In) File and Printer Sharing . Ne Allow  No System  Any
€ File and Printer Sharing (NB-Datagram-In) File and Printer Sharing Private  Yes Alow  No System  Any G Refresh
File and Printer Sharing (NE-Name-Ir) File and Printer Sharing Domai.. No Allow  No System  Any [z Exportist..
G File and Printer Sharing (NB-Name-Ir) File and Printer Sharing Private  Ves Allow  No System  Any Help
File and Printer Sharing (NB-Session-In) File and Printer Sharing Domai.. No Allow  No System  Any
@ File and Printer Sharing (NB-Session-In) File and Printer Sharing Private  Ves Alow  No System  Any Selecied ltems -
@ File and Printer Sharing (SMB-In) File and Printer Sharing Private  Ves Allow  No System  Any @ Dissble Rule
[ File and Printer Sharing (SMB-In) File and Printer Sharing & cu
@ File and Printer Sharing (Spooler Service - RPC) File and Printer Sharing Private  Ves Allow  No
File and Printer Sharing (Spaoler Service - RPC) File and Printer Sharing Domai.. No Alow  No 5 Copy
@ File and Printer Sharing (Spocler Service - RPC-EPMAP)  File and Printer Sharing Private  Ves Mllow  No K Delete
File and Printer Sharing (Spooler Service - RPC-EPMAP)  File and Printer Sharing Domai.. No Allow  No Help
File and Printer Sharing (SMB-QUIC-In) File and Printer Sharing over... Al No Allow  No
File and Printer Sharing over SMEDirect (WARP-In) File and Printer Sharing over.. All Ne Allow  No
iSCSl Service (TCP-In) iSCSl Senvice Al No Allow  No
Key Management Service (TCP-In) Key Management Service Al Ne Mlow  No
G mDNS (UDP-In) mDNS Private Ve Allow  No
€ mDNS (UDP-In) mDNS Public  Ves Alow  No
€ mDNS (UDP-In) mDNS Domain  Ves Allow  No SeSystem... Any
@ Microsoft Edge (mDNS-In) Microsoft Edge Al Yes Allow  No CiProgr..  Any
€ Microsoft Edge (mDNS-In) Microsoft Edge Webliew2 R... Al Yes Allow  No CiProgr..  Any
@ Microsoft Media Foundation Network Source IN[TCP 5... Microsoft Media Foundatio...  All Yes Allow  No SeSystem... Any
€ Microsoft Media Foundation Network Source IN [UDP 5... Microsoft Media Foundatio...  All Yes Allow  No SeSystem... Any
Alnal. - €. YL an [ [ [ Ames ~
< > >

AP Type here to search

4. In the Action pane on the right, click on Enable Rule.
5. Repeat the same steps for the File and Printer Sharing (SMB-Out) rule in the
Outbound Rules.
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& Windows Defender Firewall with Advanced Security - 8 X
File Action View Help
e x5 = H
e e
3 Inbound Rules Name Group - Profile  Enabled  Action  Ovemide  Program  Local Address  Remote ~ || Outbound Rules a
Qutbound Rules
B Connection Security Rules || & File and Printer Sharing (Echo Request - |._File and Printer Sharing Private  Yes Allow  No System  Any Any & NewRule...
+ %, Monitoring [ 7File and Printer Sharing (Echo Request - I... File and Printer Sharing Domai... 5 T Fiter by Profile ,
€ File and Printer Sharing (Echo Request - I... File and Printer Sharing Private  Ves Allow N System  Any Any
File and Printer Sharing (Echo Request - ... File and Printer Sharing Domai.. No Allow  No System Any Any T Filter by State r
8 File and Printer Sharing (LLMNR-UDP-Out) File and Printer Sharing Private  Ves Allow N %System...  Any Localsu || 7 Filter by Group 4
File and Printer Sharing (LLMNR-UDP-Out) File and Printer Sharing Domai.. No Allow  No %System...  Any Local su View »
File and Printer Sharing (NB-Datagram-0... File and Printer Sharing Domai.. No Allow  No System  Any Any
@ File and Printer Sharing (NB-Datagram-0... File and Printer Sharing Private  Ves Alow  No System  Any Any G Refresh
@ File and Printer Sharing (NB-Name-Out)  File and Printer Sharing Private  Yes Allow  No System Any Any (= Export List..
File and Printer Sharing (NB-Name-Out)  File and Printer Sharing Domai.. No Allow  No System  Any Any Help
€ File and Printer Sharing (NB-Session-Out)  File and Printer Sharing Private  Ves Allow  No System  Any Any
File and Printer Sharing (NB-Session-Out)  File and Printer Sharing Domai.. No Alow  No System  Any Any Selected Items =
@ File and Printer Sharing (SMB-Out) File and Printer Sharing Private  Ves Allow  No System  Any Any @ Disable Rule
[“]File and Printer Sharing (SMB-Out) File and Printer Sharing Domai... & cut
File and Printer Sharing (SMB-QUIC-Out) _ File and Printer Sharing over... Al No Allow  No System  Any Any .
1SCSI Service (TCP-Out) iSCSI Service Al No Allow  No %System... Any Any i Copy
€ mDNS (UDP-Out) mDNS Private  Ves Allow No %System...  Any Local su K Delete
& mDNS (UDP-Out) mDNS Domain  Ves Allow  No %System...  Any Any Help
© mDNS (UDP-Out) mDNS Public  Ves Allow  No %System...  Any Local su
€ Microsoft Media Foundation Network So... Microsoft Media Foundatio...  All Yes Allow  No %System... Any Local su
@ Narrator Narrator Al Ves Allow  No Any Any Any
© Narrator Narrator Al Yes Allow  No Any Any Any
€ Network Discovery (LLMNR-UDP-Out)  Network Discovery Private  Ves Allow  No %System... Any Local su
Network Discovery (LLMNR-UDP-Out)  Network Discovery Domai.. No Allow  No %System...  Any Local su
€ Network Discovery (NB-Datagram-Out)  Network Discovery Private  Yes Allow  No System  Any Any
Network Discovery (NB-Datagram-Out)  Network Discovery Domai.. No Allow  No System  Any Any
€ Network Discovery (NB-Name-Out) Network Discovery Private  Yes Allow  No System  Any Any
Network Discovery (NB-Name-Out) Network Discovery Domai.. No Allow  No System  Any Any
) Network Discovery (Pub WSD-Out) Network Discovery Private  Ves Allow  No %System...  Any Local su
Mkl P b WS Pt TSP R i e N b e Vot
< > € >

pel Type here to search

STEP 3: PUBLISH YOUR REMOTEAPP PROGRAM

Now that you have Remote Desktop Services installed and your firewall configured, you can
proceed to publish your RemoteApp program. Here’s how you can do it:

1. Open the Server Manager on your Windows Server machine.

2. Click on the Remote Desktop Services tab on the left-hand side.

3. In the Remote Desktop Services window, click on the Collections tab.

4. Select the collection you want to publish the RemoteApp to.

5. In the RemoteApp Programs section, click on the Tasks dropdown menu and select
Publish RemoteApp Programs.
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[ ]
T Server Manager

O ~  Server Manager * Remote Desktop Services * Collections * APP-01 Manage Took  View  Help
==y PROPERTIES CONNECTIONS i

| Overview D Properties of the collection [ TASKS ¥ ] Last refreshed on 11/26/2024 7:58:32 AM | All connections | 1 total TASKS ¥

_i ) Collection Type Session Fiter o Ok v

| 5 Collections Resources Remoate Desktop N

®e APP-01 User Group ALECIE\NeoS Users Server FODN User Session State  Log On Time Disconnect Time

» APP-Ol.albcie.com ALBCIEVouis.ouellet Active 11/26/2024 74549 AM -

b 03
REMOTEAPP PROGRAMS

Published RemateApp programs | 0 total

Publish RemoteApp Programs

Remote Desktop is published for the users of the collection. | Unpublish RemoteApp Programs |

Publish RemoteApp programs

Publishing RemoteApp programs will unpublish the Remote Desktop.

HOST SERVERS
Last refreshed on 11/26/2024 8:21:03 AM | All servers | 1 total TASKS ¥ ‘

Filter 0 (C v

AP Type here to search

6. In the Publish RemoteApp Programs Wizard, select the application you want to publish
as a RemoteApp. If your application is not listed, click on the Add... button and navigate to
the application’s executable file.
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Manage  To

to the list, click Add.

— commceTigns
Overy [ Publish RemoteApp Programs - [m} X lon 11/ TASKS ¥
Serve|
<

Colles  Select RemoteApp programs

APF User Session State Log On Time Disconnect Time ||

Select the RemoteApp programs to publish to the APP-01 collection. To add a RemoteApp program
p.com ALBCIE\ouis.ouellet Active 11/26/2024 7:45:49 AM - 1

The RemoteApp programs are populated from APP-01ALBCIE.COM.

] RemoteApp Program

[ #8Azure Arc Setup

[ Zcaleulator

[ ##Character Map

[[] @Classic Start Menu Settings

[ & Defragment and Optimize Drives
[ = Disk Cleanup

[J ~IDLE (Python 3.13 64-bit)

[ Sintemet Information Services (IIS)
[ €LisCS! Initiator

[ +# Math Input Panel

Verify that the program is installed on all the RD Session Hast servers in the collection.

Location
%SYSTEMDRIVESs\Windows\AzureArcSetuphArc...
#SYSTEMDRIVE®:\Windows\system32\win32cal...
$%SYSTEMDRIVE%\Windows\system32\charmap...
#SYSTEMDRIVE%:\Program Files\Classic Shell\C
%SYSTEMDRIVE%:\Windows\system32\dfrgui.exe
%SYSTEMDRIVE%\Windows\system32\cleanmg...
#SYSTEMDRIVE®:\Program Files\Python313\pyt...
%SYSTEMDRIVE%\Windows\system32\inetsr\l...
¥STEMDRIVE3:\Windows\system32\iscsicpl.e...
#SYSTEMDRIVE®:\Program Files\Common Files...

Next > Publish

Filter L

pel Type here to search

TASKS v |

o Note that you need to use a FQDN path to the executable file. In our case, we will
publish an application found on the G:\ drive. So, the path will be
\\<server name>\g$\neo sandbox\NEO FFW.exe.

L Type here to search

Manage Tools  View  Help
s DRADEBTIEC FOMMECTIONS
Oveny on 1172 [Tasks ~]
Serve| | f Open X -
Colle¢
« v A |« g8 > neosandbox > Start > v B | SearchStart P
APH | User Session State  Log On Time Disconnect Time ||
Organize v New folder - rogram
S . O @ preo E.com ALBCIEVouis.ouellet Active 11/26/2024 4549 AM - -
Bl Desktop  # Nome Date modified Type
¥ Downloads htmi File folder
Nextcloud wd270web File folder
NArC...
[ Documents + [ NEO_AGENT Application
cal...
& Pictures * = NEo_FRW Application
& map...
= Application (G & nEo_TOOLS Application [
B neo-BackuP Application
install lui.exe
Start
I This PC
¥ Network
i >
File name: | NEO_FFW v‘ Executable Files (*.exe:*.com:*.: ~
Next > Publish
Last ref TASKS + |
Filter E] Ohd O ‘
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7. Now select the newly added program and click on the Next button.

Server Manager * Remote Desktop Services * Collections * APP-01 Manage Tools  View  Help
— commzeTIoNS
Oven| [ Publish RemoteApp Programs - u] X |on 11/26/2024 7:58:32 AM | All connections | 1 total TASKS ¥
_I Serve| o (OR4 v
B coey Select RemoteApp programs
L User Session State  Log On Time Disconnect Time |
i Select the RemoteApp programs to publish to the APP-01 collection. To add a RemoteApp program
': to the list, click Add, Bcom ALBCIEVouisouellet Active 11/26/2024 TASAS AM. -
\
The RemoteApp programs are populated from APP-01.ALBCIE.COM.
[] RemoteApp Program Location
[] & Windows Media Player %SYSTEMDRIVE?\Program Files (x86)\Windows...
[] [#=Windows Memory Diagnostic #%SYSTEMDRIVE*:\Windows\system32\MdSche...
[J E¥Windows PowerShell ISE %SYSTEMDRIVE%\Windows\system32\Window...

[] E¥Windows PowerShell ISE (x86)  %SYSTEMDRIVEX\Windows\syswow64\Window.
[ § Windows Speech Recagnition  %SYSTEMDRIVE%\Windows\Speech\Commonis..

O uwinRAR %SYSTEMDRIVES\Program Files\WinRAR\WinR...
[] FlWordpad #4SYSTEMDRIVE%\Program Files\Windows NT\...
[] <xPS Viewer $%SYSTEMDRIVE%\Windows\system32\xpsrchv...
Rineo_Frw g\neob_sandbox\StartNEO_FFW.exe

Verify that the program is installed on all the RD Session Host servers in the collection.

Last refreshed on 11/26/2024 8:21:03 AM | All servers | 1 total [Tasks =] ‘

Filter Pl ( ~) ‘

R Type here to search

8. Review the summary of the RemoteApp program you are about to publish and click on the
Publish button.
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Overy [ Publish RemoteApp Programs

Servel

Colles

Confirmation

Rem pp Programs

Confirmation

Confirm that the list of RemoteApp programs to be published is c

1 RemoteApp program:

— O X |on11/26/2024 7:58:32 AM | All connections |1 total [Tasks =
p B @~ >
User Session State Log On Time Disconnec t Time

orrect, and then click Publish.
p.com ALBCIE\ouis.ouellet Active 11/26/2024 7:45:49 AM -

RemoteApp Pragram
BBneo Frw

g'\neob_sandbox\Start\NEQC_FFW.exe

Location

Last refreshed on 11/26/2024 8:21:03 AM | All servers | 1 total [Tasks =]
Filter s B @~ o
&

pel Type here to search

9. Once the RemoteApp program is published successfully, click on the Close button to close
the wizard.

STEP 4: PERSONALIZING YOUR REMOTEAPP PROGRAM

After publishing your RemoteApp program, you can personalize it by changing its display name,
icon, and other settings. Here’'s how you can do it:

1. In the RemoteApp Programs section, you will see the RemoteApp program you
published earlier. Right-click on the program and select Properties.
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[ ]
Server Manager
@ ~  Server Manager * Remote Desktop Services * Collections * APP-01 Manage Tools  View Help
==y PROPERTIES CONNECTIONS
Overview I® oo tics of the collecion [Tasks =] Last refreshed on 11/ TASKS ¥
Servers Collection Type Session i
= Fitter &
| M Collections Resources Remote=App Programs
®e APP-01 User Group ALECIE\NeoS Users Server FODN User Session State  Log On Time Disconnect Time |
» APP-Ol.albcie.com ALBCIEVouis.ouellet Active 11/26/2024 T:ASH49 AM. - 1
b 03
REMOTEAPP PROGRAMS
reshed on 11/26/2024 12:56:34 PM | Published RemoteApp programs...
Filter P B @~ O]
RemoteApp Program Name  Alias Visible in RD Web Access

NEO_FFW NEG==

HOST SERVERS
Last refreshed on 11/26/2024 8:21:03 AM | All servers | 1 total TASKS ¥ ‘

Filter pel )

AP Type here to search

2. In the Properties window, you can change the display name, icon, and other settings of
the RemoteApp program. Once you are done, click on the OK button to save your changes.
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@1 P Monage  Toos  view  Hep

==y PROPERTIES CONNECTIONS

[ Overview [E® properties o the collction [Tasks ~| Last refreshed on 11/26/2024 7:58:32 AM | All connections | 1 total TASKS ¥
i Servers | fia Properties - u} X
L s @ @~ S
| O} Collectio
N NEO_FFW (APP-01 Collection) User Session State Log On Time Disconnect Time |
® Show A .com ALBCIEVouis.ouellet Active 11/26/2024 74549 AM. -
" Generl
Parameters +
RemoteApp program name:

User Assignment  +

[Neo Freight - Sandbos|

File Type Associati... +
Alias:

RemateApp program location:

g\neob_sandbox\Start\NEO_FFW.exe

Show the RemateApp program in RD Web Access
® Yes O No
Type the name of the folder in which you want this RemoteApp program to appear on

the RD Web Access server. If you do not want the RemoteApp program to appear in
any folder, leave this field blank.

RemoteApp program folder:

[ ok ][ Cancel ][ apply

pel Type here to search

STEP 5: RETRIEVE YOUR REMOTEAPP PROGRAM

Now that you have published and personalized your RemoteApp program, you can retrieve it on
the RD Web Access portal. Here’s how you can do it:

1. Open a web browser on your client machine and navigate to the RD Web Access portal
URL. The URL will be in the format https://<server name>/RDWeb.
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3 B [ RDWebAccess x |+
C W © Notsecure | hitps//localhost/RDWeb/Pages/en-US/login.aspx?RetumnUrl=/RDWeb/Pages/en-US/Default.aspx

7] Import favarites | For quick access, place your favorites here on the favorites bar. Manage favorites now

Work Resources
2%) RemoteApp and Desktop Connection

Security

Warning: By logging in to this web page, you confirm
that this computer complies with your organization’s
security policy.

To protect against unauthorized access, your RD Web
Access session will automatically time out after a period
of inactivity. If your session ends, refresh your browser
and sign in again.

L Type here to search

2. Log in using your credentials.
3. In the RemoteApp Programs section, you will see the RemoteApp program you published
earlier. Click on the program to download and launch it on your client machine.
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2 DO [ RDWebAcess x e
< O MW © Notsecure | hitps//localhost/RDWeb/Pages/en-US/Default.aspx

Impart favorites | For quick access, place your favorites here on the favorites bar. Manage favorites no;
por q

 Work Resources
2%) RemoteApp and Desktop Connection

RemoteApp and Desktops

Current folder: /

Neo Freight -
Sandoax

}3 Type here to search

CONCLUSION

A MO8 = @ B

How to Publish a Remote Application using Windows Server RDS

a X

In this guide, we walked you through the process of publishing a RemoteApp using Windows

Server Remote Desktop Services. By following the steps outlined in this article, you can

centralize application management and provide users with secure and efficient access to their
work tools. Whether you are setting up RDS for the first time or looking to fine-tune your

deployment, this guide will help you get started with RemoteApp publishing. We hope you found

this article helpful and informative. If you have any questions or feedback, feel free to leave a

comment below. Good luck with your RemoteApp deployment!
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